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6  Single-Sided Reconstruction 
In this tutorial, we will look at single-sided reconstruction. It’s important to note that all analysis is done 
on tracks, and this involves both working with and analysing target tracks, including grooming track 
data, grooming sensor data, generating, and merging tracks. As such, you must know how to 
configure Debrief and how to load your data. So, before running through this tutorial, you should really 
have completed Tutorial 3 - Controlling what you view; if you haven't done this, please do so before 
attempting this tutorial. In this tutorial we will be looking at the following areas: 

● Grooming Track Data 
● Grooming Sensor Data 
● Generating Track Target 
● Merging Tracks 

Now it's time to start building and grooming the target track. 

6.1  Grooming Track Data 

This section will lead you through grooming some dodgy track data. First though, we need to load and 
understand the track data itself. 

Loading Data Files 

To load the data files: 

1. Open the Navigator view. ❏ 

2. Expand the S2R folder and locate the file “dodgy_track.rep”. ❏ 
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3. Double-click on it to load this track as a new Debrief plot. The Select track mode 
dialog will display. ❏ 

 

4. Select Over The Ground (OTG) as the track mode, and the plot and associated 
views will promptly update. ❏ 

DebriefNG Tutorials 
www.debrief.info Page 5 of 99 

http://www.debrief.info/


Advanced Analysis with Debrief 

 

6.1.1  Main Track Data 
As you can see, we have our blue ownship track called Frigate. The vessel is travelling 
from the North in a general South-East direction. There is a period of missing data on 
this track, as well as several jumps in the data itself (this will become obvious in the next 
step). 

❏ 

Note: Jumps often occur when an inertial navigation system receives an external update. We'll fix these
first. 

6.1.2  Understanding Data 

Now we’ll make the track and our data easier to understand by making the track data points visible: 

1. Open the Outline view and you’ll see Track:Frigate. ❏ 

2. Click on the drop-down arrow (to view the contents of the track) and you will see 
Positions (156 items). This is the data contained within the track. ❏ 
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3. Now, right-click on Track:Frigate, in the Outline view, and a popup menu will 
appear. ❏ 

4. Click on Frigate > Symbol frequency > All.  

 
❏ 

 

The track will now show a symbol at every data point. You can clearly see the track breaks that occur 
about 2/3rds of the way along the track, and soon after the track start (marked 1 and 2, respectively in 
the screenshot below). 
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5. To better see and understand what is happening here, we’ll turn the time labels on. 
Click on Frigate > Label Frequency > All and you will then see the time labels for 
each point. 

❏ 
6. Now zoom in and have a look at the times around each block of missing data. The 

jumps around ‘1’ (Shown in Fig a. below) have consecutive time steps, so they’re 
clearly jumps. But the break around ‘2’ (Shown in Fig b. below) shows a period of 
about 9 minutes of missing data - we’ll fill that missing period in with data from 
another source. 

❏ 

  
                               Fig a.                                                                                     Fig b. 
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We will now fix those gaps. 

6.1.3  Splitting and Fixing the First Gap 
Zoom into the large gap about 2/3rds of the way along the track (where it looks like 
almost a 90° starboard turn is made. (Fig a. shown above). ❏ 
Though this part of the track looks like 3 sharp turns were made, it’s actually three jumps in the data, 
labeled with numbers in the following screenshot. We will now go through and fix these, and will start 
by clearing the last jump. 

Here the vehicle is travelling in an ESE direction, so:  

 
 

1. Right-click on the first valid point in the southernmost leg of data (at time 0337, point 
marked 1 in the above image) and a popup menu will display. ❏ 
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2. Select Split track before 0337 and the track will split into 2 pieces. ❏ 
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3. Look at the Outline view and you will see that Track:Frigate now contains 
Positions (2 legs). ❏ 

 

We now need to align the tracks. First, we’ll hide the labels as they clutter the display. In 
the plot editor, right click on the Frigate track line then select Frigate > Label 
Frequency > None. The labels will be hidden. 

❏ 

6.1.4  Aligning the Tracks 
To align the tracks, we need to drag one track segment to the other. 

1. Click on the Drag Track Segment button  on the main toolbar (or press 
Alt+1). The Bearing Residuals view will display to the right of the plot editor and, as 
we’re now in drag mode, the mouse cursor will change to a brown hand. Don’t worry 
about the Bearing Residuals View for now, it will be covered later when we get to 
Generate Target Track. 

❏ 
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2. For this step, we need to drag the entire track segment. Click on the arrow next to 
the Mouse Drag Mode and then click Translate. in the Bearing Residuals view. ❏ 

 
3. Now, move the mouse-cursor over the first point of the lower segment of track, 

labelled 030337.25. It will turn green when it is in the correct position. ❏ 

4. Start dragging the track upwards and leftwards over the dangling end of the other 
track segment. ❏ 

As you drag the track, you will see that extension legs are plotted on each end of the 
track, with a marker circle plotted at the distance along the extension equal to the 
distance from the end point to the next first point on the track. 

❏ 

6. Now fine-tune your drag operation to put the 'target' over the last point on the blue 
track, then release the mouse-button to drop the track. ❏ 
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6.1.5  Merging Track Segments 

We will now merge the track segments: 

1. In the Outline view, right-click on Positions (2 Legs), a popup will appear. ❏ 

 

2. Click on Merge all track segments. The tracks will combine and Track:Frigate will 
once again show Positions (156 items). ❏ 
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6.1.6  Splitting and Fixing the Second Jump 

We’ll now correct the jump to the north of the one we just fixed. 

1. Open the Time Controller view and move the time slider to 030326, this is where it 
looks like the vessel is travelling west of north and then does a sharp turn to the 
south-east (marked as position 2 on the earlier image). 

 

❏ 

2. Right-click on the track data point and select Split track before 0327 and the track 
will split into 2 again. ❏ 

 

3. Now, click on the Drag Track Segment button again (or press Alt+1, if you like to 
learn the shortcut keys) and drag this end of the track down and to the left and 
position it on the dodgy point at the end of the good track section. 

❏ 
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4. In the Outline view, right-click on Positions (2 legs) and then click Merge all track 
segments to combine the tracks. ❏ 

The tracks will combine and in the Outline view, Track:Frigate will once again show Positions (156 
items). 

6.1.7  Splitting and Fixing the Third Jump 

We’ll now do the same with the third jump: 

1. Right-click on the data point at 0326 (if you hover your mouse cursor over the data 
point, a tooltip will appear giving details at that point, marked as position 3 on the 
earlier image) and select Split track before 0326. 

❏ 
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2. As before, drag this track to the good section and merge the tracks into one track. ❏ 

 

3. In the Outline view, right-click on Positions (2 legs) and then click Merge all track 
segments to combine the tracks. ❏ 
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The tracks will combine and in the Outline view, Track:Frigate will once again show Positions (156 
items). 

6.1.8  Adding Third Party Data 

We have now removed the jumps from the track. But, as we established earlier, there is still a missing 
period of data near the start of the track. Fortunately we have been able to obtain data for this period 
from a slightly less accurate typed log. We will now add this external data to fill the remaining gap. 

1. In the Navigator view, locate the file third_party_track.rep. ❏ 

2. Drag and drop the file into the plot editor and select Over The Ground (OTG) when 
the Select track mode dialog appears. ❏ 
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3. Click Ok and you will see the new track appear to the north of Track:Frigate in the 
plot editor and appear as Track:TP_Track in the Outline view. ❏ 

 

 

4. Click Fit to window button on the Main Toolbar, to view both the tracks. ❏ 

 

 

Now we need to position and merge this track with the blue track.  

DebriefNG Tutorials 
www.debrief.info Page 18 of 99 

http://www.debrief.info/


Advanced Analysis with Debrief 

6.1.9  Positioning New Data 

To make it easier to merge the tracks, we need to move the new track closer to the Frigate track. 

1. Click on the Drag whole feature toolbar button  (Alt+3), move it over the 
Track:TP_Track until the mouse cursor changes green, and then drag and drop the 
track near the period of missing data, as shown below. 

❏ 

 

2. Zoom in on the gap in the blue track. ❏ 
3. Right-click on the data point to the north of the track, and select Split track after 

0143. The blue track will split into two segments. ❏ 
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4. Click on the Drag Whole Feature button (Alt+3) and then drag and drop the top 
point of the green track onto the southern end of the blue track. Zoom in if need be. ❏ 

5. Now, click on the Drag Track Segment button on the main toolbar (Alt+1), and drag 
and drop the southern end of the green track onto the northern end of the blue track. ❏ 

 

Now that our tracks are lined up, we need to merge them. 

6.1.10  Joining Track Segments 

To join the track segments: 

1. In the Outline view, press Ctrl and click on both the tracks to select them.  ❏ 

2. Right-click and then select Group tracks into Frigate. Now, only the Track:Frigate 
remains in the Outline view. ❏ 

DebriefNG Tutorials 
www.debrief.info Page 20 of 99 

http://www.debrief.info/


Advanced Analysis with Debrief 

 

3. If you click on the drop-down arrow next to Track:Frigate you will see Positions (3 
legs). However, we don’t want a segmented track, we want a complete track. ❏ 

 

 

4. Right-click and select Merge all track segments.  ❏ 

  

You will now see in the Outline view Track:Frigate which contains Positions (164 
items). 
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Our track is now complete. 

 

 

In this stage of the tutorial, you fixed some jumps in the ownship track, and filled in 
period of missing data using external data. 

 

You can close the current plot now, as you won't need it for the next stage. No need to save changes. 

6.2  Grooming Sensor Data 

This tutorial is going to work through creating and preparing the ownship sensor data ready for 
production of Target Motion Analysis (TMA) tracks. 

Load Data Files 

For this tutorial we will be using a new set of datafiles. In the Navigator view: 

1. Go to the sample_data > S2R folder. ❏ 
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2. Double-click on the “nonsuch.rep” file. The Select track mode dialog will display. ❏ 

 

 

3. Select Dead Reckoning (DR) from the dialog and click on OK. The ownship track 
will load into the plot (Track:NONSUCH in the Outline view). ❏ 
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4. Click on the Fit to Window button on the Main Toolbar. ❏ 
5. Next, from the Navigator again, drag in the “sensor.dsf” file. The Import Sensor 

Data dialog will display. ❏ 
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6. You can go through the tabs by clicking on the Next button; but for now, you can 
also click on Finish to select the default options. ❏ 

Note: The plot area can quickly become cluttered when showing bearing lines. So, by default, sensor 
data is set to not-visible when loaded from .REP file.. 

6.2.1  Making Sensor Data Visible 

Though that is the default option, we now wish to show that sensor data we’ve just imported. So, in the 
Outline view: 

1. Click on the down-arrow next to Track:NONSUCH. ❏ 
2. Click on Sensors (1 items), to expand it. ❏ 
3. Then click on Sensor:Sensor_A (52 cuts) to select it. ❏ 
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4. In the Outline view toolbar, click on the empty tick box for SENSOR_A, and all the 
sensor data will be revealed (a pattern of bearing lines is shown either side of the 
track, we call each of these a bearing fan). 

❏ 

 

6.2.2  Resolving Ambiguity 

In our data you can see one bearing fan heading off to the WNW, and the other off towards the 
NE—this is typical of a towed sensor as they produce both a true bearing to the target, and a 
mirror-reflection, called an ambiguous bearing.  But, we have to determine which side is true and which 
is ambiguous. 

6.2.3  Dropping Ambiguous Data 

Intelligence tells us that the actual contact is off to the NW, so we can dismiss (drop) the ambiguous 
data set of bearings that generally point NE. This set of bearings are to the Starboard of the vessel 
track: 
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1. In the Outline view, right-click on  SENSOR_A(52 cuts) and then select Select all 
Children. ❏ 

 

 

2. All the 52 sensor items will be selected. ❏ 
3. Right-click on any of the entries and select Keep starboard bearing;  ❏ 
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The port bearings will disappear from view. 

 

Next, we need to edit the raw sensor data. 
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Open Grid Editor 

One method of editing the raw sensor data is by using the Grid Editor. 

1. Click on Window > Show view > Grid Editor. 
❏ 

The Grid Editor view will display on the right side of the plot editor, but it will be blank 

until we indicate the data to edit. ❏ 
6.2.4  Indicating Data to Edit 

1. The Grid Editor ‘listens out’ for the current selection on the Outline view. However, if the selected 
items in the Outline view are not suitable for editing in the grid format, nothing will be seen, e.g. as 
we have just seen, after hiding the port bearings in this tutorial and opening the grid editor, the grid 
is empty. 

2. To populate the Grid Editor: click on the Track Segment 220350.04 (826 items), 
which is just under the Track:NONSUCH in the Outline view.  ❏ 

 

The Grid Editor view will now populate. 
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Note: This behaviour can be cancelled by clicking on the lock icon button  in the Grid Editor 
toolbar. 

3. Now in the Outline view, click on the sensor data for Track:NONSUCH > 
Sensor:SENSOR_A (52 items) ❏ 
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The data from this track will populate the grid editor. 
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6.2.5  Tidying your Interface 

As mentioned previously, the interface can become easily cluttered. However, if you have a dual 
monitor and need all the windows and views open, then you can drag-and-drop views onto your other 
screen by clicking and holding the individual view tabs, and then moving them or resizing them as 
required. 

6.2.6  Viewing Grid Data 
The scrollbar on the right-hand side lets you move forward and backward through the data (the newest 
items are shown at the top). Most cells in the grid are editable, including the date, and blue and red 
buttons are provided in the toolbar to add or remove rows. Clicking on the blue Add button will insert a 
duplicate of the currently selected row immediately beneath it—a major time-saver compared to 
manually entering data. 

6.2.7  Working on an Attribute 

In addition to straight-forward text-editing of data, selecting an attribute offers further editing 
capabilities. For example: 
1. In the Frequency column, click on the header cell itself (where it says Frequency). 

you'll see a graph appear in the bottom half of the view. This graph is a ‘waterfall’ 
display of frequency, with the most recent value at the top. 

 

❏ 

 

2. Zoom in on the data by dragging your mouse on the graph using a top-left to 
bottom-right motion. ❏ 

3. Zoom out by dragging bottom-right to top-left. ❏ 

DebriefNG Tutorials 
www.debrief.info Page 32 of 99 

http://www.debrief.info/


Advanced Analysis with Debrief 

6.2.8  Fixing Dodgy Frequency Observation 

If you zoom out to look at all the frequency data you'll see that whilst this data seems 
fairly constant near the top of the dataset (along the 49.99 frequency value), there are 
occasions where the data value seems too low (when viewed in the context of a steady 
ownship track). 

 

❏ 

 

As such, we're going to fix an errant data point by dragging it into a better position.  

1. Zoom in on the data around the time 05:20. You will see that the data-point at 
05:19:11 is quite a lot lower than its neighbours. 

 

❏ 

2. Move this data point by clicking inside the square data point and dragging the 
symbol to align it with its neighbours. Remember, you can zoom in multiple times 
for greater precision. After aligning the data point, the graph looks as shown below: 

❏ 

 

6.2.9  Smoothing a Period of Data 

To smooth a block of data, we will switch to bearing data: 

DebriefNG Tutorials 
www.debrief.info Page 33 of 99 

http://www.debrief.info/


Advanced Analysis with Debrief 

1. Click on the Bearing column, the graph of bearing data will appear. 
❏ 

 

2. Around the period 05:10 to 05:20 on the graph, you will see three step-ups in the 
data, zoom in on these three steps. ❏ 

 

It appears that the last smooth data point before the steps is at 05:10:44, and the first after the steps is 
at 05:21:30. We're going to interpolate the data points between these two values. 

To do so, we must inform Debrief which points we intend to keep: 
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1. In the Grid Editor, select the row with Date Time value 09/07/22 05:10:44 by 
clicking on the empty cell to the left of the row. In the grid (the top half of the editor) 
click on the empty space to the left of row 05:10:44. 

❏ 

2. Now, hold down the Ctrl key and click on the row with Date Time value 09/07/22 
05:21:30. We have now selected the valid points at either end of the period we wish 

to correct. As soon as you do this, the Interpolate Bearing (calculator) button  
in the Grid Editor toolbar will be enabled. 

 

❏ 

 

3. Click on the Interpolate Bearing button  and the bearings for the selected data 
points will be smoothed along a straight line. 

 
 

❏ 
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Note: You can select Undo from the Edit menu, or press Ctrl+Z on your keyboard, to 
undo an interpolation operation. ❏ 
6.2.10  Getting Clever with Interpolation 

Remember, in the previous step, we only selected a single point at each end of what could be 
considered poor data. However, there are two other more advanced ways of doing an interpolation. 

1. If we had selected multiple points at the ends of the dodgy data then Debrief would have made the 
interpolated values fit through a cubic spline that passed through the selected points. 

2. If we had selected one or more points in the middle of the dodgy data (in addition to point(s) at the 
ends) then Debrief would have fitted a curve through the end and midpoints of the dataset. 

Now that we’ve tidied the sensor data, we can move on. 

6.2.11  Setting Array Offset 

As you saw in the earlier step of the tutorial, sensor data can be ambiguous; this can happen when the 
data has been produced by a sensor that is towed on a cable, behind the vessel.  In order to plot the 
bearing lines from the correct origin, we need to tell Debrief how far back the centre of the sensor is.. 

In the current scenario, Debrief is plotting the sensor cuts against the attack datum of the platform. In 
truth the centre of towed array sonar is 451m behind the datum of the platform. So, we need to apply 
an offset of 451m in this particular example for this sensor (since it’s behind, we use -451m). To do this: 

1. Select Sensor:SENSOR_A in the Outline view. ❏ 
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2. Open the Properties view and you will see the Sensor offset attribute. Enter -451 in 
this field, then press Enter. As you do so, the bearings on the plot will adjust to 
reflect this change. 

❏ 

 

3. To see where the current array centre is, we can direct Debrief to show a marker at 
the array centre. In the Outline view, click on Track:NONSUCH. ❏ 

4. Then, in the Properties view, under Visibility, you will see Plot array centre, 
change it to Yes.  ❏ 

DebriefNG Tutorials 
www.debrief.info Page 37 of 99 

http://www.debrief.info/


Advanced Analysis with Debrief 

 

A cross will appear astern of the current submarine location, in the Plot Editor. 
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6.2.12  OPTIONAL - Reducing Data Density 

Though it isn’t necessary for this particular scenario, Debrief does allow you to reduce the density of 
sensor data: 

1. In the Outline view, right-click on Sensor:SENSOR_A. ❏ 
2. In the drop-down menu, click on SENSOR_A > Visible Frequency, then select 5 

Mins. ❏ 

Adjusting these options will filter out sensor data and hide sensor observations between the specified 
frequency. The sensor cuts are not deleted, just hidden; and can be made visible again by selecting a 
smaller, visible frequency. 

Note: A more permanent way of doing this is to use the alternate option shown above to Resample 
position data at, and select the required period. 

We've now got a track with lovely smooth sensor data. 
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Saving Your Data 

As mentioned earlier, this sensor data and track will be required for the next tutorial; so, if you don’t 
intend to jump straight onto it, ensure you save this file: 

1. Click on File > Save. ❏ 
2. You have to save the file with the dpf extension, and also select the folder where 

you will save the file. ❏ 
3. Enter the filename, e.g. nonsuch_plus_data.dpf. ❏ 
4. Click on Ok. ❏ 
6.3  Generating Target Track 

This tutorial guides you through creating a target track segment from bearing data to represent a period 
of straight-line motion; this can be interpreted as a Manual Target Motion Analysis (TMA) Solution. 

 
1. We will be using the track and sensor data from the previous example, so if you 

closed it, reopen it now. ❏ 
2. In this tutorial, we will be concentrating on the plot, so you can close the Grid Editor 

view. ❏ 
6.3.1  Deciding the Contact Period 

A capable analyst will be able to recognise a couple of periods of steady bearing rate that lend 
themselves to being the basis of TMA solutions. 

If you earlier filtered the sensor data, you should reveal it all again before continuing, since we want to 
use all available data when generating this TMA track. 

The first period of cuts we’re going to be using here are the first 15 or so sensor cuts (marked 1 in the 
below screenshot). We can see that at the end of this period, there are 2 bearing lines very close 
together and then a gap (marked 2 in the screenshot below), followed by a small group of 3 bearing 
lines, and then another gap (marked 3 in the screenshot below). After this second gap, there is then a 
period of about 10 unsteady cuts, and then another steady period; we'll be using that for a solution a 
little later. Experience shows us that, since Ownship is steady throughout this period, these bearing 
patterns indicate that the subject vessel was first on a straight course, then it manoeuvred, then it 
assumed a second straight course. 
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6.3.2  Highlighting Contacts 

We will change the color of the contacts to make our first solution easier to see and work on: 

1. Identify the last bearing line you will use for the first period of steady bearing data. ❏ 
2. Double-click somewhere on that bearing line and it will then be highlighted in the 

Outline view (I selected the data point named 090722 044127). ❏ 
3. Alternatively, you can click on that item in the Outline view to select it. ❏ 
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4. Now, scroll back up to the start of the sensor data, hold down the Shift key, and then 
click on the first entry—this period of sensor data is now selected. ❏ 
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5. To change the colour, right-click anywhere on the selected group and select Multiple 
items > Color > Orange. ❏ 

 

The bearing lines in the plot area and the selected items in the Outline view will turn 
orange. ❏ 

 

6.3.3  Generating the TMA segment 

Next, we're going to create a solution from this selected (orange) data. When we generate a TMA 
segment based on sensor data, Debrief creates a track segment of steady course/speed data points, 
with one data-point at the time of each sensor cut used to generate the segment. Debrief has a 
Generate TMA Wizard to help you with this. 
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With the set of data still selected in the Outline view (or reselect it if you've lost the selection): 

1. Right-click on the selected sensor data and select Generate TMA solution from 
selected cuts.  ❏ 

 

The Generate TMA Segment dialog will show, asking you to specify the offset to the track start. 

2. Enter a range of 1 nautical mile (nm), and you can leave the bearing of 300.8 as is 
(it's using the bearing from our first sensor cut). ❏ 
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3. Click Next and you will see the initial solution dialog. ❏ 

 

4. Based on our understanding and analysis of the sensor fan in the plot area, enter 
220 for the initial estimate of the course and 6 kts for the speed estimate. Click Next 
and you will be prompted to select a color. 

❏ 
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5. Select Orange and Click on Finish. ❏ 
A red track will appear on the plot. Note that the Orange value provided in the last tab of 
the wizard was to select what color to shade the sensor cuts - the TMA legs are always 
painted red.  The track is labelled with the TMA solution and the time of the first cut used 
(TMA_220415.22 on my plot—all solutions have times in their name to make them 
easier to manage). 

❏ 
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6.3.4  Recognising Track Data 

We will now look at the track data for this TMA solution in the Outline view. 
1. In the Outline view, click on the arrow next to the new track 

Track:TMA_220415.22)and you will see the Positions (14 positions) child item. ❏ 

 

2. If you look at the icon for this particular child item, you will see that it shows a 
straight-line section of data with a tiny red compass rose on it (to indicate that this a 
forecasted straight leg of track). However, if you also look at the equivalent object 
for Track:NONSUCH, you can see that it shows a non-straight-line set of positions 
(with 2 turns - to indicate that this is a series of absolute measured positions). Also, 

❏ 
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note that on the plot, the name of the Track:NONSUCH TMA segment is shown in 
italics, to denote that it's not based on actual position recordings. 

6.3.5  Put the Tracks on the Tote 

We are going to use a statistical graph to improve the accuracy of the TMA leg we created. To do this, 
we need to tell Debrief which is the primary track (the one carrying the sensor), and which is the 
secondary track (the TMA track we’re developing). As we’ve been generating the TMA track, Debrief 
has automatically assigned the secondary track as the new TMA track, and the primary track as the 
platform hosting the sensors used to produce the TMA track. 

Note: if you wish to change the secondary track used in single-sided reconstruction, just select the track 
in the Outline View then click on the 2 icon in the Outline toolbar, to mark it as secondary. 

1.  Verify we have the correct tracks assigned by viewing the Track Tote ❏ 

 

 

Debrief now knows what tracks we wish to compare, so we will manipulate the track segment to 
minimise bearing and frequency residuals. But first, let’s look at the Bearing Residuals view. 

6.3.6  The Bearing Residuals View 

To open the Bearing Residuals view, click on the Drag Track Segment ( ) button 
on the Debrief toolbar . The Bearing Residuals view will display to the right of the Plot 
Editor. 

❏ 

Note: if the Bearing Residuals view is small, make it bigger for this next exercise. As with all views, 
you can resize or move them by moving your mouse over the sides of a view and, when the cursor 
changes to a multi-directional arrow, drag in any of the directions indicated; or, if required, by clicking 
on the view’s tab, you can then either drag the view to another part of the display or to another 
connected monitor. 
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Looking at the Bearing Residuals view, you will see that the central graph is titled Error. The aim with 
this view is for the analyst to reduce the residual error—the error between the measured and the 
calculated bearing—by manipulating the track manually in the plot editor. As this is carried out, a 
real-time view of the track manipulation is displayed in the Bearing Residuals view. 

 
This manipulation is carried out using one of the translate, rotate, stretch, and shear modes, which 
are located on the Bearing Residual view toolbar, in conjunction with Debrief’s Drag Track functions, 
which are located on the main toolbar. 

When you have selected your drag mode and started to manipulate the active track in the plot editor, 
the resultant effects will be seen in both panes in the Bearing Residuals view: Absolute (degs) and 
Error (degs). The aim here is to drag/position the active track to reduce the calculated error to a 
minimum, i.e. the Error (degs) central pane shows an error of 0 degrees. 

This in conjunction with the analyst’s knowledge, experience, and other available data (such as 
narratives), which will enable them to perform an accurate track reconstruction. Let’s do this now. 
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6.3.7  Manipulating Track Segment 
1. In the Bearing Residuals view, Absolute (degs) pane, you can see 2 lines: 

Measured (the bearing recorded by the sonar), and Calculated (the calculated 
bearing between each ownship position and each position of the hypothetical subject 
vessel). 

❏ 

Note: if you don’t see any lines here, click the ship’s wheel toolbar icon twice in the 
Bearing Residuals view to switch the plotting of Ownship Course off then back on. 
The Bearing Residuals view will now update to show the measured/calculated data. ❏ 

The Error (degs) pane of the Bearing Residuals view at the start time of 04:15:22 
(obtained from the grid editor data), shows a residual error of just under 10° (you can 
zoom in by clicking and dragging top-left to bottom-right in the pane). We need to reduce 
this as much as possible, so must select the drag operation most suitable. 

 

❏ 

2. There are 4 drag mode buttons in the Bearing Residuals view, these control how you drag the 

track. Click on the Drag Track Segment button  on the Bearing Residuals View toolbar and 
the 4 drag modes will display.  

 

They are labelled, and have functions, as follows: 

○ Translate - you can drag either end of the track: this changes range and bearing from the 
source, but maintains target course and speed. 

○ Rotate - here you can drag either end of the track: doing so maintains the target speed but 
changes the target course. 

You can also drag the track from the middle in this mode, but when rotate, stretch, or shear mode is 
selected, a Translate operation is performed (the button in the Bearing Residuals view doesn’t switch 
to Translate though). 

○ Stretch - here you can also drag either end or the middle of the track: stretch allows you to 
maintain the target course but change the target speed. If the centre-point of the track is 
dragged, the track moves in and out adjusting as necessary to adhere to the start/end points on 
the host platform bearing fan. 
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○ Shear - you can drag either end or the middle of the track: this option allows you to change both 
target course and speed. 

Note: whilst the Translate and Rotate operations are available for all types of track segments, only the 
Stretch and Shear operations are suitable for application to straight-line TMA Segments (the sums 
just get too complex when applying these operations to real track data). To help you, the hand cursor 
will only turn green over straight-line TMA Segment hot-spots. 

As mentioned earlier, though you select the above drag options in the Bearing Residuals view, these 
selections are used in conjunction with the following drag buttons from the main toolbar: 

○ Stretch, Shear, and Rotate are only used with the Drag Track Segment function. 

○ Translate can be used with Drag Track Segment, Drag Component, or Drag Whole Feature. 

By default, the mouse cursor hand is brown. When it is this colour, you cannot modify the track from 
this particular point—it isn’t a hot-spot. However, if you move the cursor over a point on the track which 
does allow you to manipulate (or move) that point—a hot-spot—the cursor will change colour to green. 
As mentioned in the bullet points above, this will either be at the end, and/or in the middle of a track. 

3. Now, select Shear mode and then click on Drag Track Segment on the main toolbar
and move your cursor to the start point of TMA_220415.22. ❏ 

4. When you are in the position to drag the track point, the mouse cursor will turn 
green, you can now drag. ❏ 

Bear in mind, the data points we have must correspond to the bearing fans, so the 
objective here is to both reduce the residual AND position the start of the track on the 
bearing line. You will probably need to zoom in on the track and in the Error (degs) 
pane. 

❏ 
5. In the bigger picture, you will try to minimise errors by moving the start AND end 

points of the track leg. But, since this leg starts at a bearing of 300.8 from the primary
track (to match the first bearing), the initial error at the start of the leg should already 
be zero - as in the following screenshot.  Note: there’s a good chance it’s at the 
wrong range though - so you may have to come back and manipulate it further.. 

 

❏ 
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6. Do the same with the end of the track. As you can see from the image below, it is 

possible to reduce the error to 0.4 degrees either side.  Also note that the 
background to the error plot has gone green, to indicate “acceptable”.  The cut-off 
value used to indicate an acceptable solution is defined in Debrief Properties, under 
TMA Operations.. 

❏ 

 

Now we’ll look at expanding on this with another TMA segment.  
6.3.8  Generating Second TMA Segment 
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Looking at the sensor data, it would appear that the turn is represented by about 14 cuts before a 
further straight line section of data. 

As you look at the fan of sensor data, you can see there's an early block of bearing lines that are 
roughly parallel (marked 1 in the below screenshot). Then, towards the end of the track, the bearing 
lines appear to converge steadily around a single point (marked 2 in the below screenshot). In between 
these two periods of steady data, the lines jump around a little (marked 3 in the below screenshot), and 
this represents the period where the target vessel is changing course and/or speed. 

 

Now, let's work with the plot again… 

1. Click on the first sensor cut of the second steady set of bearings - that cut will be 
highlighted in the Outline view (I selected 090722 050326). ❏ 

2. Now scroll down to the end of the data and hold Shift and then click the last sensor 
cut. We've now selected the cuts to be used for the second track segment. ❏ 

3. Right-click on one of the selected items and select Multiple items > Color > Green. 
The cuts will turn green. ❏ 
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The plot and the Outline view will update to show the color change.  
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4. Right-click again on the selected cuts and select Generate TMA solution from 
selected cuts,  ❏ 

 

 

The Generate TMA segment dialog will display. 
 

 

 

a. Enter a range of 1 nautical mile (nm) and you can leave the bearing of 292.3 
as-is (it's using the bearing from our first sensor cut in this selection, which 
represents as good a start point as any). 

 

❏ 

b. Click Next and the initial solution dialog will display. ❏ 
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c. Based on our understanding and analysis of the sensor fan in the plot area, enter 
220 for the initial estimate of the course (but it won’t be, because the earlier 
spacing in the bearing fan shows us that the vessel has turned) and 6 kts for the 
speed estimate. 

❏ 

d. Click Next and the dialog to select the color will display. ❏ 

 

 

e. Click on Finish and the second track will be plotted. ❏ 
The new track will display in the plot and the Outline view.   
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As mentioned, due to the earlier turn, the new track is probably wrong; but we can manipulate the track 
and see what solution we can arrive at. 

6.3.9  Refining Second Solution 

Now, locate this new solution in the Outline view: 

1. Click on the track to select it (mine is called Track:TMA_220503.26). ❏ 
2. Note that Debrief has automagically assigned this track as the secondary track in the 

Track Tote. ❏ 
3. Now, let us start manipulating and refining this solution. Click on Drag Track 

Segment on the main toolbar (or press Alt+1) and move your cursor to the start 
point of TMA_220503.26.  

❏ 
4. When you are in the position to drag the track point, the mouse cursor will turn 

green. Click and start dragging the track.  
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5. Again try to minimise the errors for this new leg of TMA.  I was able to reduce the 
error down to around 0.5 degrees either side. 

 

 

6.4  Merging Tracks 

6.4.1  Selecting and Merge Tracks 

In the previous tutorial we generated two track sections and, though they are separate tracks on our 
plot, we know that they belong to the same vessel; so, we will now combine them into a single track. 

1. Using the Outline view, Ctrl+click to select both tracks. ❏ 
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2. Right-click on one of the selected tracks and select Group tracks into 
TMA_220415.22 (it doesn’t matter which one you select). ❏ 

3. The tracks will merge into 1 (the ‘other’ track will disappear). However, there is still 
that large ‘turn gap’ remaining. We will now use Debrief to infill, or bridge, that gap. ❏ 

 

6.4.2  Providing Infill Positions 

Debrief is capable of linking track sections by infilling the gap between them.  Instead of just creating a 
straight leg of data between the two legs, Debrief fits a curve to the end of the first leg and the start of 
the second one - to allow on leg to flow into the other. 
1. Click to expand Track:TMA_220415.22 and you will see it contains Positions (2 

legs). ❏ 
2. Expand this and you will see 2 tracks with different numbers of items (in mine, I have 

220415.22 (14 positions) and 220503.26 (20 positions)). ❏ 
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3. Select both tracks. (Ctrl+click) ❏ 
4. Right-click on either one and select Generate infill segment. ❏ 

 

Note that a second Generate infll segment command is provided.  Use this if your 
two legs are very close together in time, and it will give Debrief permission to delete 
enough points from the second leg in order to allow for a dynamic infill to be inserted. 

 

5. You'll see a new segment appear both in the Outline view and in the plot. ❏ 
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Notice that the infill segment is shown as a dotted line. This indicates that this track 
segment is not based on any real bearing data, it's just been calculated to join both 
tracks. 

❏ 

Also, if you look in the Outline view at the Track Segments, you will see the 3 individual 
tracks listed. Take note of the icons: 2 are straight line tracks, and the other shows a 
turn. 

 
 

❏ 

 

6.4.3  Merging Tracks 

You can continue to keep your target track represented as 3 or more track segments for as long as you 
like.  If you try dragging either of the TMA track segments you created, you’ll see the the infill adjusts 
itself to optimally fit those legs.  If you view a Speed-Time (or Heading-Time) plot of the combined TMA 
track, you’ll see that Debrief attempts to smooth speed and course, in addition to position.  But, when 
you need to export the data for presentation or subsequent analysis then you must merge them: 

1. Select the parent item for the track segments (Positions (3 legs)). ❏ 
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2. Right-click on it and select Merge all track segments. The tracks will merge and in 
the Outline view you will see Positions (54 positions).  ❏ 

6.5  Conclusion 

That’s the Single-sided reconstruction tutorial using Debrief finished. I hope you can see how easy it is 
to do this using Debrief, as well as appreciate the power and potential for working with your data. The 
next tutorial takes us to the next step and walks us through a Semi-automatic Target Motion Analysis 
scenario. 

 

Signed: ________________ Date: ___________________ 
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7  Semi-Automatic TMA Walkthrough 
Semi Automatic Track Construction (SATC) was developed in response to the challenges of handling 
and solving multi-leg target tracks using Debrief's manual TMA algorithms. SATC provides an 
automated means of obtaining an optimal solution based upon disparate "packages" of analyst 
knowledge, measured data, and logical/geometric deductions (collectively these are called 
“contributions”). This tutorial looks at:  

● Single Leg TMA Solution 
● Multi Leg TMA Solution 

7.1  Single Leg TMA Solution 
The first tutorial in this set will involve an engagement where there is just a single leg of target data. 
Here we follow 5 steps:  

● Loading a Simple Scenario 
● Creating a Scenario 
● Generating a Solution 
● Converting the Solution to a Track 

7.1.1  Loading a Simple Scenario 

Note:Before you begin this section, you should know how to generate a project and generate links to 
existing data.  

To produce target solutions we must load some ownship data. We’ll do that now. 

Find SATC Subfolder and Load Ownship Track 

In the Navigator view: 

1. Open the SATC sub-folder and either drag the “L1_OwnshipTrack.rep” file into the 
Debrief plot area or right click and select Open With > Debrief Plot Editor. ❏ 
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2. In the Select track mode dialog, select Over the Ground (OTG) mode. ❏ 

You will now see the blue ownship track in your Plot Editor. Click Fit to window button  to view 
the entire plot.  

 

Load Ownship Sensor Data 
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Next, we will load the ownship sensor data (this is the sonar data): 

1. Drag and drop the “L1_OwnshipSensor.dsf” file onto the plot, the Import Sensor 
Wizard will display. ❏ 

 

2. You can leave this sensor contact name as Plain. Click Next. ❏ 

 

3. Choose a color for the sensor data, then click Next. ❏ 
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4. Select the value check box so that the sensor data will be visible, then click Next. ❏ 

 

5. In the Rainbow shades dialog, select the check box to shade the sensor cuts in a 
range of colors. Click Finish. ❏ 
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The dialog box will close and the fan of ownship bearing data (sonar data) will be seen radiating 
north-west and north from the ownship track.  

 

If you don’t see this, then repeat the above steps (making sure you’ve loaded the correct files). 

Now we’ve loaded our data and we can now create a scenario. 

7.1.2  Creating a Scenario 

Debrief uses the term scenario to describe the combination of data that is collated in order for SATC 
to produce an optimal 'solution'. Let’s create our first scenario now. 

7.1.2.1  Creating a Scenario Based on Cuts 

We will use all of the ownship sensor data to create our scenario: 

1. Open the Outline view. ❏ 
2. Open Track:OWNSHIP. ❏ 
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3. The ownship track has a Sensors (1 items) object, open this and you will see the 
single block of sensor data, titled Sensor:Plain (11 cuts). ❏ 

 

4. Right-click on it and select SemiAuto TMA > Create new scenario from these 
bearings. ❏ 
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7.1.2.2  Creating Scenario Based upon Cuts 

A new item with the name 121213.14 (1 items) has been created in the Outline view (the item name is 
auto-selected from the Date-Time-Group (DTG) of the first item in the bearing data).  Notice the use of 
the calculator symbol to indicate this computer-generated track solution. 

 

You will also see that the Maintain Contributions view has opened. A contribution is a piece of 
information that is used in the development of target solutions. This information can be in the form of a 
measurement (range, bearing or frequency); an analyst forecast ( i.e. speed or range), or one of a 
hidden set of analysis contributions that deduce further constraints based on other contributions. This 
view is used to create and manage your scenario data. 
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7.1.2.3  Changing the Scenario Name 

As nice as it is to try and remember a new set of telephone numbers, every time you create a new 
scenario. It makes sense to rename the scenario to something more meaningful. To rename the 
scenario 

1. In the Outline view, click on the scenario name 121213.14 to select it. ❏ 
2. In the Properties view, (Windows > Show View > Properties, if it isn’t visible) 

change the Name value to Single Leg. ❏ 

 

3. Click OK. ❏ 
7.1.2.4  Understanding the Maintain Contributions View 

Main Contributions View 
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In the Maintain Contributions view you can see that, in the Analyst Contributions section, there is a 
single Bearing Measurement - Bearing data item listed. 

This is the bearing data that will be used to inform all of the subsequent contributions. 

7.1.2.5  Viewing the Bearing Measurement Contributions 

The Bearing Measurement Contribution is the set of bearings that represent the unknown target 
track. You can see that the contribution has an estimated error value of +/- 3 degs, which means the 
algorithm will only consider solutions that are within 3 degrees of these bearing measurements. 

To view these measurements: 
1. Select the track Single Leg in the Outline view. ❏ 

 

2. In the Properties view, set the attribute value Show location constraints to Yes. ❏ 
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3. In the Maintain Contributions view, click on the Calculate Solution button. 

 
❏ 

A set of "pie-slices" will now appear on the plot, showing the 3 degree allowable error on each bearing 
measurement. 
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4. Still in the Maintain Contributions view, expand the Bearing Measurement - 
Bearing Data contribution and you will see that it is possible to change the error 
value on this bearing data by moving the slider. As you move and release the slider 
you will see the pie slices expand and contract (you may need to toggle the 
Auto-Recalc of Constraints button in the Preferences area to initiate this). 

 
 
 

❏ 

 

Note: The Auto-Recalc of Constraints is a two-state button that is normally depressed. But, if you 
have a complex scenario that takes some time to update, you may wish to un-check this button - then 
the screen will no longer be refreshed as you are interactively adjusting any contributions. 

7.1.2.6  Specifying a Target Leg 

Note: In this sample data, the imported bearings have a maximum range of 12,000 yards (yds). In the 
absence of a range estimate SATC will restrict them to 30kyds, to keep things manageable, and to 
avoid your PC requiring the Ferranti Reset. 

Also, before we continue, Debrief must be reset to a predictable state, so: 
1. Restore the Analyst Contribution to 3 degrees. ❏ 
2. In the Properties view, set the attribute value of Show Location Constraints to No. ❏ 
It’s possible that your deep analysis skills have led you to believe that all of these cuts relate to a single 
leg of target data: where the target maintains course and speed through the period of interest - this is of 
great value to the TMA algorithms, since it means the contact must travel through those pie slices in a 
straight line. 
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1. In the Outline view, select Track:Ownship > Sensors (1 items), and then 
right-click on Sensor:Plain (11 cuts). ❏ 

2. From the drop-down menu, select Semi Auto TMA > Add to Single Leg > New 
Straight Leg for period covered by [sensor cuts]. ❏ 

 

3. When the New contribution dialog opens up, name this contribution Leg limits. ❏ 

 

4. Click Ok. ❏ 
In the Outline view, you will see Single Leg (1 item) has changed to Single Leg (2 items). 
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7.1.2.7  Understanding the Contributions 

So, now there are two contributions for this scenario: 

1. a set of bearings through which a solution must travel. 

2. an indication that the target will have travelled on a single course and speed throughout the entire 
engagement. 

An observant analyst will have noticed that our two ownship turns have provided a valuable change in 
bearing rate - exactly what a TMA algorithm needs. 

So, now that we’ve provided the TMA algorithm with some viable data, let's see it calculate a solution. 

7.1.3  Generating a Solution 

Now we have provided background data to SATC, we can generate a solution. 

7.1.3.1  Calculating the Solution 

Now we're going to generate the solution for this scenario. Before we do this: 

1. Click on the Fit to Window button to ensure you can see the ownship track and the 
rough area where the target should be ❏ 

2. Click on the Calculate Solution button. ❏ 
By default, the SATC is set to Low precision and uses relaxed constraints. The quite sparse bearing 
data and ownship maneuvers used in this scenario means that there aren't very many candidate 
solutions, and an answer will be generated within a second or so. When it has completed its 
calculations, a new track will appear on the plot. 
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As you can see, the track will be the same color as you specified for the bearing data in the Bearing 
Import Wizard. 

My computer returned a solution of 9.0 kts on 269°. 

You can alter the Precision setting as you require (to medium or high), but you must click on Calculate 
Solution each time to generate it. 

 

As you can see from the image below, which superimposes all 3 precision solutions—Low (red), 
Middle (yellow), and High (blue)—it is unlikely that you will get a better solution with this set of data; 
but, you will notice that the Performance graph (below the Maintain Contributions view) processes 
more slowly as SATC homes in on a particular solution. You will see that the x-axis shows more cycles 
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have been run through, and that each one moves more slowly. The bars shown in the performance 
graph represent the sum of the contribution errors at each contact position (state). 

 

7.1.3.2  Marking your Own Homework 

The data we're using here is from a simulation tool; and this means we have the actual target track to 
compare against. 

1. Drag the file “L1_SubjectTrack.rep” into the plot area. ❏ 

 

2. In the Select track mode dialog, select Over the Ground (OTG) as the import 
mode. ❏ 

The track will now display on the plot as a solid red line. 
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Now, compare the SATC solution with the actual target track. You will see that SATC is actually quite 
close, with a greater error to the East, near the start. This is because of the low bearing rate near the 
start; however, both tracks appear to be on a roughly parallel course. 

We now have an SATC-generated solution which is very close to the actual target track. 

7.1.4  Importing a Solution 

Debrief has a range of analysis and export capabilities we can use on track objects; however, as our 
current suggested solution isn't yet a track, we need to convert it. 

Select Scenario 

If you've followed the instructions in the previous tutorial correctly then you will have a 
scenario named Single Leg (2 items) in your Outline view. Click on it to select it. ❏ 
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7.1.4.1  Converting to Composite Track 

To convert the current solution to a Composite Track: 
1. Right-click on Single Leg (2 items). ❏ 
2. Select Convert to manual TMA track. ❏ 

 

You will see a new track appear on the plot and you will see a new item in the Outline view marked as 
a Track followed by the same name of this scenario (mine is named Track:Single Leg_0). 
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7.1.4.2  Renaming to Avoid Confusion 

To prevent potential problems, we will now rename the imported track: 
1. In the Outline view, click on Track:Single Leg_0 to select it. ❏ 
2. In the Properties view, change its name to Single Leg TMA. ❏ 
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3. Click OK. ❏ 
7.1.4.3  Tidying the Plot 

It’s very easy for the plot to become cluttered, so we will now use the Outline view to hide the red 
SUBJECT track: 
1. Click on Track:Subject to select it. ❏ 
2. Right-click and select SUBJECT and then untick Visible. ❏ 

 

The track will disappear from view and only the OWNSHIP and Single Leg TMA tracks are visible. 
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7.1.4.4  Tuning the TMA solution Manually 

Now we will adjust this solution in the same way we did for the Single-Sided Reconstruction: 

1. Click on the Drag Track Segment button  in the Main Toolbar and the 
Bearing Residuals view will display in the right side. 

❏ 

2. Mark the OWNSHIP track as the primary track, and the Single Leg TMA track as 
the secondary track (using the mini-toolbar in the Outline view). ❏ 

Now you can drag the Single Leg TMA track and see the error residuals move. 

Note: the Absolute (degs) values graph is easier to read in this instance if you select Centre bearing 

axis on North button . 
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7.1.4.5  Importing as Standalone Track 

Note: The manual-track fine-tuning process steps you have just carried out are more suited to complex 
scenarios where, because of the lack of contributions available for the system-produced SATC solution, 
the analyst decides to use the manual TMA tools to groom the track by hand. 

However, in this scenario, as the raw SATC did produce a perfectly acceptable solution, we can discard 
the manual track and import the original TMA solution: 

1. In the Outline view, right-click on Track:Single Leg TMA and select Delete Single 
Leg TMA. ❏ 

 

Then, to import our original TMA solution:  
2. Right-click on Single Leg (2 items) and select Merge to Track. ❏ 
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You will now see the track has appeared in the Outline view as Track:Single Leg_0. 
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7.1.4.6  Marking your Own Homework 

Currently loaded into Debrief we have both our imported TMA Solution (Track:Single Leg_0), and our 
Truth Track (Track:SUBJECT); we can now use the application to calculate the distance between 
these two tracks. 

1. Select Track:Single Leg_0 and Track:SUBJECT in the Outline view (Ctrl+click to 
multi-select). ❏ 

2. Right click on either track, select View XY Plot.  ❏ 
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The View time-variable plot dialog box will display. 

 

3. Select Range, click Ok and the Select Primary dialog will open. ❏ 

 

4. Select Track:SUBJECT as the primary track, and click on Ok. The Subject Range 
vs Time Plot graph will display. ❏ 
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This graph shows the start of the track has an error of approximately 130 yds, reducing to 60 near the 
end. This seems quite good considering the target ranges vary from 8000 to 3000 yards from ownship. 

7.1.5  Conclusion 

That's the single leg solution complete, so you can now close this Debrief plot. In the next tutorial, we 
will look at multi leg solutions. 

7.2  Multi Leg Solution 
In this, the more advanced multi leg solution, the scenario has several target zigs, and a number of 
contributions are required to obtain an optimal solution. Similar to the single leg solution, we need to 
load the data, then groom it before we can play with the multi-legs. 

Loading the data 

Load “L2_Scenario.dpf” by dragging it from the Navigator view into the plot area. ❏ 
As soon as the plot opens, you will see a blue Ownship track, with a dark green bearing fan. 

DebriefNG Tutorials 
www.debrief.info Page 87 of 99 

http://www.debrief.info/


Advanced Analysis with Debrief 

 

7.2.1  Grooming the Data 

Now we’ve loaded the data, we now need to groom it. First, we need to understand what our data 
shows, then we create the scenario, before moving onto zig detection and generating and grooming 
target legs. 

7.2.1.1  Understanding Data 

To understand what is happening here, use the Debrief Time Controller and the Track Tote to 
familiarise yourself with the general motion of the OWNSHIP track. As you do, you will see that the 
vessel starts in the North-East of the plot, then travels quite slowly at 2.5 knots, with two straight legs. 

7.2.1.2  Creating Scenario 

The most significant block of information that Debrief requires to generate a solution is the bearing data 
- we need to mark this information as such. 

In this scenario, we will use all of the Ownship sensor data: 
1. In the Outline view, click the drop-down arrow next to Track:Ownship. ❏ 
2. Click Sensors (1 items) to expand it. ❏ 
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3. Select Sensor:Plain (145 cuts), right-click and select Semi Auto TMA > Create 
new scenario from these bearings. ❏ 

 

As with the previous tutorial, you will see the new scenario (called 121200.00 (1 items)) appear in the 
Outline view, and the Maintain Contributions view will open, with just one contribution. 

 

7.2.1.3  Introduction to Zig Detection 

The SATC algorithm is only capable of determining periods of target track for when periods the target is 
travelling at steady course and speed.  Without this assumption the number of permutations would 
make the task impossible. 

An algorithm has been developed that considers the current rate of change of bearing, and determines 
if the bearing rate matches that for two platforms in steady state.  Where the bearing rate doesn’t match 
an acceptable range, one or both platforms must be changing course or speed. 

This algorithm uses the set of measured bearings, and produces a set of target legs.  

7.2.1.4  Generating the Target Legs 

As mentioned in the previous step, the process begins with determining the ownship legs. As analysts, 
we can see what is happening on screen, but Debrief cannot; and, the main information source to 
enable Debrief to detect target zigs and generate target legs is the bearing data. 
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1. In the Maintain Contributions view, expand the Bearing Measurement - Bearing 
data section. Near the bottom of the control you'll see the MDA (Manoeuvre 
Detection Algorithm) section. 

❏ 

 

2. Now Click on Slice Tgt legs and the MDA algorithm will produce a series of legs - 
see the new Straight Leg Forecast entries listed, together with zones shaded green 
below in the Target Legs chart. 

❏ 
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7.2.1.5  Grooming the Target Legs 

Let's have a look at what the algorithm produces from these target legs: 

1. Click on Calculate Solution. The algorithm will produce a target track and show it on 

the plot. 

 

❏ 

2. These legs closely match the bearing fans. But, prior knowledge indicates that contact almost 

certainly isn’t travelling at 28 knots on the third leg.  
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7.2.2  Playing with Legs 

Once we're confident in the set of target legs we can move on to capture more of the analyst's 
knowledge and refine the target track. 

7.2.2.1  Introducing Speed Constraint 

Fortunately, the ship’s log for the subject vessel gives a broad indication of the target’s speed during 
the engagement. We will now add it to our scenario. 

7.2.2.2  Adding Speed Constraint 

There are a number of ways to add a speed constraint: 

● At the per-leg level we can expand a Straight Leg Forecast and enter min/max/estimate 
values for course or speed for each leg. 

● We can apply a speed constraint to the whole engagement. To do this, we just right-click on any 
contribution that covers the whole time period. The full set of bearings is a good candidate for 
this. 

To do the latter: 

1. In the Outline view, right-click on the Bearing Data item and select Add Speed 
Forecast for period covered by [selected legs]. ❏ 

 

The New Contribution dialog will display. 
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2. In the New contribution dialog box, enter Overall speed as the name of this 
contribution. ❏ 

3. Click on Ok and, since the addition of the new contribution means that the existing 
solution is no longer valid, you will see the target solution disappear. ❏ 

7.2.2.3  Specifying Speed Constraint 

The exercise observer recorded that the target was doing around 9 knots during the whole exercise, so 
we must enter this constraint to allow for speed keeping errors: 
 
1. In the Maintain Contributions view, expand the Speed Forecast control. ❏ 
2. Enter a minimum speed of 8 knots. ❏ 
3. A maximum speed of 10 knots. ❏ 
4. An (optional) estimate of 9 knots. ❏ 
5. Click on the Calculate Solution button. ❏ 
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In the Performance tab you will see the effectiveness of both the Bearing Data and the Overall speed 
estimates. The bars are shaded according to the respective color-coded constraint. 

 

You will also see the new set of target legs, that conform to the new speed constraints: 
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Note: In the above screenshot, the Tgt-3 for the target is heading down at SE. Analysts actually 
believe it was heading NW, since the contact was getting quieter. Since this is the final leg of the 
dataset, we don’t have any successive legs to tie it to - so it could be heading SE or NW, and still 
match the bearings. 

If we wished to manually “force” leg titled Tgt-3 to be NW, then we could right-click on it in the 
Outline View and select Add Course Forecast for period covered by [selected legs]. 
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From the contribution that appears, we would just set minimum and maximum courses to be, say 270 
and 350, as in this screenshot: 

 

Instead of that, however, we’ll experiment with tuning the solution manually. 

7.2.2.4  Generating Manual TMA Solution 

We will now use this information to develop a manual TMA solution. 
 
1. In the Outline view, right-click on the TMA solution (in this case it is 121200.00) 

and select Convert to manual TMA track. ❏ 

A manual solution (Track:121200.00_0) will now appear in the Outline view, and the 
auto TMA solution will be hidden. 

 

❏ 

Note that the new solution has been automatically marked as Secondary. We are now ready to 
manually adjust the solution. 

Also note that the new TMA Solution comprises 5 legs. This is because Debrief has generated 
Dynamic Infills between the TMA steady legs. 

7.2.2.5  Tuning TMA Solution Manually 

To manually tune the TMA solution: 
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1. In the Outline view, ensure the track is selected. ❏ 
2. Click on the Drag Track Segment button on the main toolbar and the Bearing 

Residuals view will display. ❏ 

Note: if the Bearing Residuals window is empty, open the Track Tote view and check that your 
primary track is Ownship and your secondary track is 121200.00_0. If they aren’t, assign these 
accordingly in the Outline view. 

Alternatively, if the ownship sensor cuts are not visible, you will need to clear the Only draw dots for 

visible sensor points button  in the Bearing Residuals view toolbar. 
1. Now, in the Bearing Residuals view, click on the Shear button. ❏ 

 

2. In the plot area, begin dragging track segments to minimise the bearing errors. Note, 
you could manually try to switch the third leg to run in a NW direction, rather than 
SE. 

❏ 

Don't worry if your track segment dragging results in a mangled solution, you can delete the manual 
track from the Outline view and generate a new one from your existing solution. 

7.2.2.6  Merging Track Segments 

When you are finally happy with your solution it’s time to merge the separate track segments into a 
formal track. 
1. In the Outline view, expand your manual TMA solution. ❏ 
2. Right-click on the Positions (5 legs)  and, from the popup menu, select Merge all 

track segments. ❏ 
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You now have a track for the subject vessel that can be used for further analysis. 

7.2.2.7  Mark your answers 

To check how well you did: 
1. In the Outline view, select Track:Subject. ❏ 
2. Click on Reveal Selected Items (make visible). ❏ 
This is the actual Truth Track; so, how does it compare against your track? 

If you'd like a more quantitative score, produce an XY Plot of range between your solution and the truth 
track: 

1. Ctrl-click on both tracks to select them. ❏ 

2. Right-click and select View XY Plot. ❏ 
3. In the View time-variable plot dialog, select Range. ❏ 
4. Click on Ok. ❏ 
You can now see a plot of how well you did. 

Ideally, you should be able to achieve an accuracy of around 2000 yds, which is not bad when we're 
using sensor data at around 20000 yds. 

7.3  Conclusion 
And that concludes Debrief's Semi-Automatic Track Construction and the end of this tutorial. Don’t 
forget that we have a comprehensive user manual to help you. 
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Good luck! 

 

 

Signed: ________________ Date: ___________________ 
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